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Important User Information
In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or 
application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements 
associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the 
examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in 
this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

.

ATTENTION: Identifies information about practices or circumstances where there is a chance of person injury.

ATTENTION: Identifies information about practices or circumstances that can lead to property damage, or economic 
loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence

IMPORTANT Identifies information that is critical for successful application and understanding of the product.



Table of Contents
Preface

Chapter 1: Product Overview

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1  
Display Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
Rotating the Operating and Control Panel (Display) . . . . . . . . . . 1-8

Chapter 2: Initial Set Up

Unpacking and Inspecting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
Set Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Connecting the Power Cord . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3 

Chapter 3: Installing the Printer Driver

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1
Windows XP/Windows 2000 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Network Connection  . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5

Windows Vista . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Network Connection  . . . . . . . . . . . . . . . . . . . . . . . . . 3-15

Chapter 4: ClearTools™ Software 

Installing the ClearTools Software. . . . . . . . . . . . . . . . . . . . . . . . . 4-1
Printer Driver Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Printer Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Adjusting the Marker Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4

Chapter 5: Calibration

General Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-1
Specific Card Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-5

Chapter 6: First Time Use

Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1
Heating Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3

Chapter 7: Maintenance

General Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1
Cleaning the Print Heads . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1
Replacing Ink Cartridges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-4
Replacing the Ink Collector Unit  . . . . . . . . . . . . . . . . . . . . . . . . . 7-6
General Cleaning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-8
Transport and Shipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-9

Chapter 8: Trouble Shooting

LED Error Displays  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-1
General Trouble Shooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2
Error Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4

Appendix

Technical Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Appendix-1





Rockwell Automation Publication 1492-UM08A-EN-P - June 2010 i

Preface

Preface

Information Concerning the 
Technical Documentation 

The documentation for the ClearMark printer consists of the following parts:

• User Manual (Publication Number 1492-UM008A-EN-P)

This manual is found on the CD. It has been written for personnel who 
will be operating, performing simple maintenance, and service work on the 
printer.

• Quick Start Guide (Publication Number 1492-QS002A-EN-P)

These instructions have been written for personnel who will be installing 
and setting up the printer. These instructions detail the use of the 
ClearMark printer.

This manual will help you set up and use the ClearMark printer. It contains 
information concerning the initial setup of the printer and the use of the 
Clear Tools software. In addition, it contains troubleshooting tips, technical 
specifications, and ordering data.

Accuracy of the Technical 
Documentation

These operating instructions have been written with great attention to detail. 
However, unless otherwise required by law we do not guarantee that the data, 
images and drawings are accurate or complete nor do we accept liability for their 
contents. Rockwell Automation general terms and conditions of sale apply in 
their respective valid form.

Subject to change without notice.

Terms of Use This device is intended for use in applications only as described in the operating 
instructions. Any other form of usage is not permitted and can lead to accidents 
or destruction of the printer. Using the printer in non-approved applications will 
lead immediately to the expiration of all guarantee and warranty claims on the 
part of the operator against the manufacturer.

Using the selected printer for purposes other than those specified or failure to 
observe the operating instructions and warning notes can lead to serious 
malfunctions that may result in personal injury or damage to property.
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Safety and the Environment  Safety Instructions

Depending on the model, the ClearMark printer is configured with a power 
supply for AC voltage of either 110V or 220V.

Disposal of the ink cartridge

The empty ink cartridges can be disposed of with general waste.

Disposal of the ink waste pad

If the operating panel displays the following messages: Ink Collector is full/Replace 
Ink Collector Unit or Ink Collector almost full, the ink waste pad must be replaced.

The ink waste pad contains a collecting membrane.

Dispose of the ink collector unit with general waste.

ATTENTION: Only plug the printer into a grounded outlet. 

Turn off all relevant devices (computer, printer, or accessories) before 
connecting or disconnecting the devices. The printer should only be 
operated in a dry environment with no exposure to moisture (splashed 
water, fog, etc.).

ATTENTION: Parts of the device can become hot during operation.

At the end of its life, this equipment should be 
collected separately from any unsorted municipal waste
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Application The individual marking of equipment can be quickly and conveniently carried 
out using the ClearMark printer. The ClearMark printer uses a innovative,  
permanently-readable printing process to print marker cards for switching 
devices, machines, terminal blocks, cables, conductors and other industrial 
controls.  A secure and permanent label is made possible and is resistant to wiping 
and scratching, UV stability, and high printing resolution for all marker cards.

The ClearMark printer allows you to print very small fonts, graphics, colors, logos 
and even images. Even the smallest diagrams are easy to read - permitting you to 
increase the marker's information density.

The Rockwell Automation warranty does not cover faults or damage to the 
printer resulting from the use of non-approved or unsuitable accessories or 
consumable materials.

Furthermore, Rockwell Automation can make no guarantee for the printing 
quality and resistance when third-party products such as markers or inks are used.

Insert Marker Cards As Shown

Please insert the marker card with the project marker surface facing the feed-in 
direction.

Figure P.1 - Marker Insertion instructions

ATTENTION: Someone should always monitor the printer as it 
is running!
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Figure P.2 - Warning Label on Device

Safety Precautions Read the following instructions carefully before starting up the ClearMark 
printer. Observe the warnings and notices on the ClearMark printer at all times.

•  The printer weighs approx. 65 lb. (30 kg). Therefore, always use two 
people when moving. To lift the printer, use the recessed grips at the front 
and rear of the device.

•  Do not block or cover openings in the housing of the ClearMark printer.

• Do not insert any unsuitable objects into these openings.

•  Do not spill any fluids onto the ClearMark printer.

•  The supply voltage must correspond to the system voltage given on the 
ClearMark printer serial label located adjacent to the power cord 
connections.

ATTENTION: Do not disassemble the printer!

Do not open the printer housing!

This exposes you to a risk of injury!

There are no serviceable parts inside the printer.

You will forfeit all rights under the warranty if you open the 
cover!
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• Do not open the device when it is printing!

Unplug the ClearMark printer and contact a qualified service engineer if any of 
the following occurs:

• The power cord or plug are worn or damaged.
• Fluid has penetrated into the ClearMark printer.
• The ClearMark printer enclosure is damaged.
• The ClearMark printer does not operate normally or the standard of 

performance varies noticeably.

Precautionary Measures Observe the following when using the ClearMark printer, handling ink 
cartridges, or choosing a location to install the ClearMark printer:

Working with the ClearMark printer
• Check the wipe and scratch resistance of the ink at regular intervals.

• After printing, allow the marker card to cool for a few seconds, then 
remove your printouts from the output rail of the ClearMark printer.

• Before transporting the ClearMark printer, ensure that it is switched off, 
and that the ink cartridges are installed correctly.

ATTENTION: Only connect the printer to a properly grounded 
and correctly-fused outlet. Do not use an outlet already being 
used by devices that are turned on and off at regular intervals, 
such as photocopiers or fans. Do not connect the ClearMark 
printer to either a switched or a timer-controlled outlet.

ATTENTION: Do not use the computer system near possible 
electromagnetic disturbance fields such as loudspeakers or base 
transceiver stations for mobile telephones.

ATTENTION: Never use damaged or worn power cables. Do not 
exceed the nominal ampere rating on extension cords or outlets.

ATTENTION: Do not move the print head by hand, as this could 
damage the ClearMark printer. Do not carry out repairs to the 
device.

ATTENTION: Always use the main power switch on the 
operating panel to turn the ClearMark printer on and off.
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• The ClearMark printer should always be transported in a horizontal 
position.  Improper transport can lead to leaked ink and contamination or 
damage to the printer.

ATTENTION: Do not operate the ClearMark printer without a 
cover. Never reach into the printer openings while the printer is 
operating.
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Chapter 1

Product Overview

Introduction This chapter provides a brief overview of the features and functionality of the 
ClearMark Printer

Description The ClearMark printer is a printing system for labelling Allen-Bradley markers. 
Primarily, the Bulletin 1492 Marker Cards.

The data is created on a PC using the ClearTools  labelling software. This 
software is also used for the configuration of the printer drivers.

A marker card is fed by the system into the printing unit and is printed with 
thermally-cured ink and then transferred to a heating unit. In this unit, the ink is 
then cured with a special heat lamps.

Finally, the marker card is conveyed out of the system and can be removed.

The ClearMark printer should not be turned off since it automatically switches to 
the standby/energy-saving mode when not in use.

Figure 1.1 - ClearMark Overview/Components

Maintenance Cover for Printing System 
Connections

Output Rail

Ink Cartridge Cover

Maintenance Cover 
for Ink Waste Pad

Operating and Control 
Panel Display

Loader - Input
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Figure 1.2 - Connections

Figure 1.3 - Enclosure

Figure 1.4 - Ink Cartridge Lid

Power 
Cord

USB 
Cable

Network
Cable 

(if desired)

Recessed Grips
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Figure 1.5 - Loader and Maintenance Cover for Ink Waste Pad

Figure 1.6 - Maintenance Cover for Printing System

Figure 1.7 - Printer

InputOutput



1-4 Rockwell Automation Publication 1492-UM008A-EN-P - June 2010

Chapter 1        Product Overview

Figure 1.8 - Input (Loader)

Figure 1.9 - Output



Rockwell Automation Publication 1492-UM008A-EN-P - June 2010 1-5

Product Overview           Chapter 1

Figure 1.10 - Display

Display Functions Power

Use this button to turn the printer on and off.

In order to turn on the printer, press the button until it is illuminated.

After the printer has been turned on, the [Power] button blinks until the printer 
is operational. The button then remains illuminated.

The Power button also blinks when the printer is processing data.

When the printer is turned off, the button blinks slowly until the printer is fully 
powered off. The button is then no longer illuminated. The printer is in 
"Standby" mode. 

Reminder: During normal use, the ClearMark printer should not be powered 
off. It will automatically switch to energy-saving mode when not in use.
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Display

This shows the current status of the printer and any error messages.

Menu

Press this button to change or view the printer settings.

Online

This button indicates whether the printer is offline or online. Press this button in 
order to switch between the offline and online modes.

When the button is lit, the printer is online and data can be received from the 
host computer. When not illuminated, the printer is offline and data is not 
received.

Form Feed

This button ensures that the printer prints any data received while online which 
was not initially printed because the marker card format or type was not the 
specified format or type.

 Job-Reset

When the printer is online, you can press this button to abort a running print job.

Esc

Press this button in order to get back to the previous screen.

▲▼ 

These buttons can be used to raise or lower the setting values on the display.

By holding down one of the buttons, you can quickly raise or lower the displayed 
value in increments of 10. These buttons are also used to navigate through the 
various menus.
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� 

Press this button in order to execute the menu command shown on the display 
(Enter Key).

Heating 1

Activates or deactivates the full heat output of the fuser.

Heating 2

Activates or deactivates the reduced heat output of the fuser.

Loader

Activates or deactivates the loader function (feeds the marker card through).

Inlay

Activates or deactivates the inlay function (for printing materials other than 
marker cards).

Temp LED 

This is the status indicator for overheating in the fusing unit. This LED 
illuminates during overheating. It goes out as soon as the printer reaches its 
normal operating temperature.
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Status / Error Display

This is the status indicator when printing. 

Blue:
• The print job is being processed.
• There are additional print jobs in the queue.
• A general process error has occurred while processing this print job.
• Ink collecting tray is full

Orange:
• Ink collecting tray is almost full.

Data IN LED

This LED flashes when the printer is receiving data from the computer. The 
display is illuminated when pending data is waiting to be printed.

Transport LED

This shows the status or an error relating to the transport system.

Rotating the Operating and 
Control Panel (Display)

As delivered, the display is designed for operating from the right.

It can also be rotated 180° counter-clockwise in 90° increments. It can be turned 
back 180° until it snaps into place. The unit can be re-positioned by using the 
round indentations. 

Figure 1.11 - Display

Figure 1.12 - Rotation of the Display
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Initial Set Up

Unpacking and Inspecting Carefully take all parts out of the packaging. Always use two people to move the 
printer and make use of the grips available.

Figure 2.1 - Clearance Requirements - in. (mm)

Figure 2.1 shows the necessary clearance requirements for optimal air circulation 
and insertion and removal of the marker cards. Also listed are the grip locations 
for moving.

Parts Included in Delivery

After you have received the ClearMark printer and taken it and all accessories out 
of its packaging, make sure that you have received all of the following parts:

• ClearMark printer
• Power cord
• USB cable

IMPORTANT Keep original packaging for future shipment.

IMPORTANT Refer to the Quick Start Guide (Publication Number 
1492-QS002A-EN-P) for set-up instructions.

9.84 
(250)

7.87 
(200)

9.84 
(250)

GripGrip

3.94
(100)

3.94
(100)

Grip Grip
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• Quick Start Guide
• ClearMark Printer user manual (this document)
• ClearTools Software user manual
• Printer driver and ClearTools software CD
• Two marker cards (Cat. No. 1492-M5X5)
• Output rail

Set Up Select a suitable location for the ClearMark printer, considering the following 
factors:

• Place the ClearMark printer on a flat, stable surface larger than the base 
area of the printer.

• The ClearMark printer will not operate properly if it is tilted or at an 
angle.

• Ensure there is sufficient space to allow the marker cards to be ejected 
without obstruction from the printer.

• Avoid installing the ClearMark printer in any location where it is 
subject to rapid changes in temperature and humidity.

• Ensure that the ClearMark printer is not exposed to direct sunlight, 
strong light or excessive heat.

• Avoid locations subject to impact shocks or vibrations. Do not place on 
a table joined to other tables to avoid transmission of vibration.

• Do not install the device in dust-filled surroundings.
• When installing, ensure that the ClearMark printer is sufficiently 

ventilated on all sides.
• Install the ClearMark Printer near a socket outlet, ensuring that the 

plug can be easily removed at all times.

Dimensions of the printer system (including the out-put rail):
• L x W x H, approx.  50 x 19.7 x 11.8 in. (1270 x 500 x 300 mm)
• Weight: Approx. 65 lb. (30 kg)

IMPORTANT A LAN cable and extra ink cartridges are not shipped with printer

IMPORTANT Observe recommended minimum clearance requirements and install 
printer on a freely accessible, sturdy, level surface.
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Output Rail Installation

Insert the output rail so that it snaps into position.

Figure 2.2 - Output Rail Installation

 Connecting the power cord The supply voltage must correspond to the system voltage given on the 
ClearMark printer serial label. Connect the plug-in power connection to a nearby 
grounded outlet, ensuring it is easily accessible.

ATTENTION: Only connect the printer to a properly grounded and 
correctly-fused outlet. Do not use an outlet already being used by devices 
that are turned on and off at regular intervals, such as copiers or fans.

ATTENTION: Do not connect to a switched or timer-controlled outlet.

ATTENTION: Never use a worn out or damaged power cord. 

If you connect the ClearMark printer to a power supply via an extension 
cable, ensure that the total nominal current of all the devices connected 
to the extension cable does not exceed the ampere rating for that 
extension cable.  In addition, you should ensure that the total nominal 
current of all the devices plugged into the wall-mounted socket outlet 
does not exceed the ampere rating for that socket outlet. 

Keep the main cable (power cord) undamaged and keep it in its original 
state. Do not place any heavy objects on it. Do not pull on it with force 
and do not bend it more than necessary. Ignoring these instructions can 
lead to electrocution or fire.
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Unplug the ClearMark Printer and contact a qualified service engineer if either of 
the following occurs:

• The power cord is worn or damaged.
• The plug is worn or damaged.

Power supply

Connect the power cord to the ClearMark Printer and grounded outlet (220-240 
VAC or 100-120 VAC). Make sure that the plug is completely inserted.

Top fuse:
• 10 A / delay-action 230V AC
• (12.5 A / delay-action 115V AC) → Power circuit of the fusing unit

Bottom fuse:
• 2 A / delay-action 230/115V AC → Printer controller

This device is subject to special conditions regarding its connection to the main 
power supply (for European countries).

The supply impedance at the point of connection to the public electricity supply 
must not exceed (0.14 +i 0.09) Ohm. If it does, consult the power supply 
company before connecting the device to the public supply system.

ATTENTION:  Do not carry out repairs to the device.
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Installing the Printer Driver

Introduction All necessary printer driver settings are made automatically by the ClearTools 
software. 

Before you begin with the installation of the software and the printer driver, 
insert the "Printer Driver & Software" CD-ROM (included in delivery) into the 
CD-ROM drive of your computer. The CD starts automatically and shows the 
language-selection screen (shown below). If the CD does not start automatically, 
start the Setup.exe file found on the CD.

Figure 3.1 - Language Selection

1. Please select your language and confirm by clicking the [�] button.

Figure 3.2 - Printer Driver Installation

1. First install the printer driver.

2. Select Install→ Printer Driver→ ClearMark Printer→ 
Vista/XP/Win2000

For WindowsXP/Win 2000 see page 3-2.  For Windows Vista, see page 3-11
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Windows XP/Windows 2000

USB port - Windows XP/ Windows 2000

Figure 3.3 - License Agreement

1. Accept the license agreement and click [Next].

Figure 3.4 - Connecting the Printer

2. Select the USB cable option and click [Next]. (For LAN settings, see page 
3-5)
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Figure 3.5 - Installing the Printer Driver

3. Make sure the printer is turned off. Click [Next].

Figure 3.6 - Automatic Recognition of the USB Connection

4. Turn on the printer when its window appears. The printer driver will now 
be installed.

Figure 3.7 - Default Printer 
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5. Do not define the printer as the default printer. Click [No].

Figure 3.8 - Status Monitor

6. Choose "Newer Display Status Monitor"

Figure 3.9 - Installation of Printer Driver Successful

7. Click [Finish].
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Network Connection - Windows XP/ Windows 2000

On the printer press the Menu key, the arrow keys and the Enter key to select the 
submenu 'Host interface 'followed by 'Network setup' and 'IP address'. Press the 
Enter key again to display the IP address of the printer. Now enter <http://IP 
address/ipp> in your Web browser (please enter the printer IP address using the 
following format: XXX.XXX.XXX). If the IP address contains blocks with less 
than three digits per block, please add leading zeroes (for example, 10 -> 010).

The System window will now open and display the hostname of the printer 
'RNPAXXXXX'. Here XXXXX represents a figure.

If you are unable to open the web address that you have just entered you may have 
to deactivate the proxy server just to enable you to gain access to this page. 
Proceed as follows to access this option in the Internet Explorer: click the 'Tools' 
menu then 'Internet Options', click the 'Connections' tab and then click the 
'LAN settings' button. Now uncheck the option 'Use a proxy server for your 
LAN'.

Figure 3.10 - LAN Settings

Once you have carried out the procedures described above, take the CD-ROM 
'Printer Driver & Software' included in the range of supply and insert it into the 
CD-ROM drive of your PC. The CD-ROM will start automatically.

At this point you must select a language. If the CD does not start automatically 
click SETUP.EXE on the CD. Ensure you have administrator rights for your 
local computer.

On the main menu 'Printer Driver & Software' select the option 'Printer drivers', 
'ClearMark Printer' and the Operating System 'VISTA/XP/Win2000'.
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Figure 3.11 - License Agreement

1. Accept the license agreement and click [Next].

Figure 3.12 - Connecting the Printer

2. Select the LAN Connection option and click [Next].
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Figure 3.13 - Installing the Printer Driver

3. Select the option shown above and click [Next].

Figure 3.14 - Default Printer

4. Double click on the printer names to display the printer settings.

5. Click [Continue].
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Figure 3.15 - Status Monitor

6. Deactive the status monitor and click [Next].

Figure 3.16 - Installation of the Printer Driver Successful

7. Select the option shown above and click [Finish].

8. Open Start →Settings →Printer (Windows 2000), or Start → Printer and 
Fax (XP). Select the printer which you have just installed and then right 
click to get to properties.
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Figure 3.17 - Printer Driver Properties

9. Click on the "Ports"  tab and then [Add Port].

Figure 3.18 - Printer Connections

10. Select "Standard TCP/IP Port" and [New Port].
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Figure 3.19 - TCP/IP Printer Port

11. Click [Next].

Figure 3.20 - Add Port

12. Enter the hostname (see above- RNPAXXXXX) of the printer in this 
window. (Here, XXXX is the number of your printer.)
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Figure 3.21 - Exiting the Install Wizard

The connection is then added.

13. Verify that a connection to the selected printer exists in Device.

14. In the dialog box for the finished installation, click [Finish].

Windows VISTA

USB Port - Windows VISTA

1. Insert the "Printer Driver & Software" CD-ROM (included in delivery) 
into the CD-ROM drive of your computer. The CD starts automatically 
and waits for the language to be selected. If the CD does not start 
automatically, start the Setup.exe file found on the CD.

2. On the main menu 'Printer Driver & Software' select the option 'Printer 
drivers', 'ClearMark Printer' and the Operating System. The Operating 
System will now issue a message stating that 'an unidentified program 
wants to access your computer'.

3. Click [Allow].

The installation process will now start.
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Figure 3.22 - License Agreement

1. Accept the license agreement and click [Next].

Figure 3.23 - Printer Port

2. Select the option Connect with USB cable then click [Next].
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Figure 3.24 - Installing the Printer Driver

3. Make sure that the printer is turned off. Click [Next].

Figure 3.25 - Automatic Recognition of USB Connection

4. When this window appears, turn on the printer. The printer driver will 
now be installed.
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Figure 3.26 - Default Printer

5. Do not set this printer as the system default printer. Click [No].

Figure 3.27 - Status Monitor

6. Deactivate the status monitor and click [Next].
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Figure 3.28 - Installation of the Printer Driver Successful

7. After you click [Finish], the installation of the printer driver is finished.

Network Connection - Windows VISTA

1. On the printer press the Menu key, the arrow keys and the Enter key to 
select the submenu 'Host interface' followed by 'Network setup' and 'IP 
address'.

2. Press the Enter key again to display the IP address of the printer.

3. Now enter <http://IP address/ipp> in your Web browser (please enter the 
printer IP address using the following format: XXX.XXX.XXX). If the IP 
address contains blocks with less than three digits per block, please add 
leading zeroes (for example, 10 -> 010).

The System window will now open and display the hostname of the printer 
'RNPAXXXXX'. Here XXXXX represents a figure.

If  you are unable to open the web address that you have just entered you 
may have to deactivate the proxy server just to enable you to gain access to 
this page. Proceed as follows to access this option in the Internet Explorer: 
click the 'Tools' menu then 'Internet options', click the 'Connections' tab 
and then click the 'LAN settings' button. Now uncheck the option 'Use a 
proxy server for your LAN'.



3-16 Rockwell Automation Publication 1492-UM008A-EN-P - June 2010

Chapter 3        Installing the Printer Driver

Figure 3.29 - Internet Options

Figure 3.30 - LAN Settings

4. Once you have carried out the procedures described above, take the 
CD-ROM 'Printer Driver & Software' included in the range of supply and 
insert it into the CD-ROM drive of your PC. The CD-ROM will start 
automatically. At this point you must select a language.
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If the CD does not start automatically click SETUP.EXE on the CD. 
Ensure you have administrator rights for your local computer.

5. On the main menu 'Printer Driver & Software' select Printer drivers→ 
ClearMark Printer→VISTA/XP/Win2000.

6. The Operating System will now issue a message stating that "an 
unidentified program wants to access your computer". Click [Allow].

The installation process will now start.

Figure 3.31 - License Agreement

7. Accept the license agreement and click [Next].
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Figure 3.32 - Connecting the printer

8. Select the LAN Connection option and click [Next].

Figure 3.33 - Installing the Printer Driver

9. Select the option shown above and click [Next].
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Figure 3.34 - Default Printer

10. Double click on the printer names to display the printer settings.

11. Click [Continue].

Figure 3.35 - Status Monitor

12. Deactivate the status monitor and click [Next].
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Figure 3.36 - Installation of Printer Driver Successful

13. Select the option shown above and click [Finish].

14. Open Start → Control Panel and under "Hardware and Sound" select 
[Printer]. Select the printer which you have just installed and then right 
click to get to properties.

Figure 3.37 - Printer Driver Properties

15. Select the "Ports" tab and then [Add Port].
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Figure 3.38 - Printer Connections

16. Select "Standard TCP/IP port" and click [New Port].

Figure 3.39 - TCP/IP Printer Port

17. Click [Next].
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Figure 3.40 - Add Port

18. Enter the hostname (see above - RNPAXXXXX) of the printer in this 
window. (Here, XXXXX is the number of your printer.)

Figure 3.41 - Exiting the Install Wizard

The connection is then added.

19. Verify that a connection to the selected printers exists in "Device".

20. In the dialog box for the finished installation, click [Finish].
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Installing the ClearTools 
Software

Please note that this printing system is optimized for Microsoft Windows 2000, 
XP and VISTA. For installation and operation, you require a basic knowledge of 
Microsoft Windows.

Before you begin with the installation of the software and the printer driver, 
insert the "Printer Driver & Software" CD-ROM (included in delivery) into the 
CD-ROM drive of your computer. The CD starts automatically.

Figure 4.1 - Software Installation Software Installation

1.  From the main menu of the "Printer Driver & Software" program, select 
Install→ Software→ ClearTools→ VISTA/XP/Win2000.



4-2 Rockwell Automation Publication 1492-UM008A-EN-P - June 2010

Chapter 4        ClearTools Software Installation

2. The installation starts automatically and the installation assistant appears 
on the screen. Please follow the instructions in the installation assistant by 
clicking [Next].

3. Accept the license agreement and click [Next].

4. Click [Next] to install default folder.

5. Click [Install].

Figure 4.2 - Installation Wizard

6. After the installation successfully concludes, click [Finish].

Figure 4.3 - Completing installation

7. The software can now be started from its desktop icon, or 
from the selection → Start→ Programs → ClearTools.

Printer Driver Settings If you are not using ClearTools, please contact your local Rockwell Automation 
sales office or Allen-Bradley distributor for additional information. The driver 
settings can be done directly in the ClearTools software.

Please take the following steps:

1. Select "Tools" from the menu pull-down, and then click [Options].
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2. In the Options window, select the "ClearMark" folder.

Figure 4.4 - Configuring ClearMark

3. Click [Execute Printer driver configuration].

4. Select the print quality. The recommended setting is "Quality Print". 
Please select "Premium Print" only when printing intricate graphics. This 
will result in more ink usage and a slower print process.

5. Confirm the driver settings by clicking [Finish].

Figure 4.5 - Selecting the print quality

Printer Setup The printer setup is intended for setting the precise zero point and for setting the 
different marker card types.
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Please read and refer to the Quick Start Guide and ClearTools manual, found on 
the "Printer Driver & Software" CD.

After the software installation these are available on your computer.

Adjust Marker Type In order to compensate for physical changes to the marker cards, refer to specific 
card calibration on page 5-5.

Please read and refer to the ClearTools manual, found on the "Printer Driver & 
Software" CD.
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General Calibration Calibrating the ClearMark Printer

Note: Affects all Cards

1. To open ClearTools, Go to: Start→Programs→Rockwell Automation→ 
ClearTools→ClearTools.

2.  Double click on "1492-M5X5" in the variant list.
3.  In the first column, 5 marker tags down, place a capital "X" as shown. ( See 

Figure 5.1.)  Note: It is critical to select this tag. 

Figure 5.1 - 

4. On the display on the top of the printer, press the [Heating 1] and 
[Heating 2] buttons so that the LED lights are off.
a. The printed card can be cleaned with water and used again.
b. The distances required for calibrating the printer are not distorted by 

the heat effects.

5. Select File→Print. 

3
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6. In the pull down menu select the GelSprinter GX3000/3050N printer . 
See Figure 5.2.

Figure 5.2 - 

7. Click [Map]. (The 1492-M5X5 is now linked to this  printer)
8. Click [OK], with the "As Printer" selected.  See Figure 5.2.
9. Click [Calibration].

10. Verify a value of "7" in the box marked "Left" and a "66" in the box marked 
"Top".  See Figure 5.3. 

11. Click [Save]. 

Figure 5.3 - 

12. Load the 1492-M5X5 card. 
13. Click on Print. (Pop-up window appears: leave heat off and click [OK].)
14. If the "X" is centered: proceed to step 19.                      
15.  If the "X" is not centered: go to File -> Print, and click [Calibration].
16.  See Figure 5.4 for horizontal adjustments.
17.  See Figure 5.5 for vertical adjustments. 

Note: When making adjustments use maximum increments of 0.5 mm. 

7

6

9

13

8

11

10
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18. After making a change, Click [Save]. Then click [Print] to check the card.   
a. If centered go to step 19, If not go back to step 15.

Figure 5.4 - 

Figure 5.5 - 

 
 
 

 
 

 
 

If “X” appears
on this half of
the card
increase the
“Left” number
to move it back 
to center. 

If “X” appears
on this half of
the card
decrease the
“Left” number
to move it back 
to center. 

 
 
 
 

 
 

 
 

If “X” appears on this half of
the card increase the “Top” number
to move it back to center. 

If “X” appears on this half of
the card decrease the “Top” number
to move it back to center. 
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19. Place a capital "X" in the upper right corner as shown( See Figure 5.6 ). 
You can leave the "X" in the first column because it will not move with 
these upcoming changes.

20. Go to File→Print, and click [Print].

Figure 5.6 - 

21. If the "X" is centered you are done calibrating  and are ready to print.  (See 
section on printing). 

22.  If the "X" is not centered. Go to File→ Set Printer Correction. ( See 
Figure 5.7).

Figure 5.7 - 

19

21

25

23

24
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23.   See Figure 5.8 for horizontal adjustments 
24.  See Figure 5.9 for vertical adjustments.

Figure 5.8 - 

Figure 5.9 - 

25. After making changes to the "Width" or "Height", Click [OK]. Then select 
File→Print to check the card.

Specific Marker Card Calibration (If Needed) 

Notes:  Affects only the specific marker card you are adjusting.

Continue with this section only if you are not satisfied with the calibration 
after steps 1-25.

General calibration may not create the best printing alignment on all types of 
marker cards. To create calibration values for specific marker cards, complete the 
steps below. 

1. Similar to what was done with general calibration, in the first column of 
the desired marker card, place a capital "X" five marker tags down. (See 
Figure 5.10)

Notes: It is critical to select this tag. 
            Turn off the heat setting so the card can be cleaned and re-used.

 

If “X“ appears on 
this half of the 
card decrease 
the “Actual Width 
(X)“ number to 
move it back to 
center. 
 

If “X“ appears on 
this half of the 
card increase 
the “Actual Width 
(X)“ number to 
move it back to 
center. 
 

 If “X“ appears on this half of the 
card increase the “Actual Height 
(Y) “ number to move it back to 
center. 

If “X“ appears on this half of the 
card decrease the “Actual Height 
(Y) “ number to move it back to 
center. 
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Figure 5.10 -   

2. Print the test card 

3. If the text is not centered, go to File→ Adjust Marker Type (See 
Figure 5.11)

Adjusting Offset of Cards

Figure 5.11 -  

4. If the "X" on the test card is not centered, make adjustments to the offset 
values. 

Note: If the "X" is centered, leave the offset values at 0. 

5. To make horizontal adjustments, see Figure 5.12.

6. To make vertical adjustments, see Figure 5.13.

1

10 11

13 14
5

6
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Figure 5.12 - 

Figure 5.13 - 

                Notes: -When making adjustments use maximum increments of 0.5mm.

To enter a negative value, add a dash "-" before the desired number

Adjusting Width/Height of Cards

Note: Only complete these steps if you are not satisfied with calibrating the 
offset values

7. To determine if the width or height of a card needs to be adjusted, place a 
capital "X" in all of the far left, bottom, and far right tags.  

8. Print the test card

9. If the width is not set correctly, the text will slowly drift out of alignment 
from left to right (See Figure 5.14). 

 
 
 

 
 

 
 

If “X” appears
on this half of
the card
increase the
“Offset X (a)” value
to move it back 
to center. 

If “X” appears
on this half of
the card
decrease the
“Offset X (a)” value
to move it back 
to center. 

 
 
 
 

 
 

 
 

If “X” appears on this half of
the card increase the “Offset Y (b)” value
to move it back to center. 

If “X” appears on this half of
the card decrease the “Offset Y (b)” value
to move it back to center. 
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Note: For examples of drifting text, (See Figure 5.14 and Figure 5.15). Use 
the yellow center lines as reference. 

Figure 5.14 -  

Note to edit: Center all lines on each column of the marker tags

10. If the text gradually drifts to the right of the tags, decrease the 
[Width (X):] value.

11. 11. If the text gradually drifts to the left of the tags, increase the 
[Width (X):] value

12. If the height is not set correctly, the text will gradually drift out of 
alignment from top to bottom. (See Figure 5.15)

Figure 5.15 -  

Note to edit: Center all lines on each column of the marker tags**

13. If the text gradually drifts up, decrease the [Height (Y):] value

14. If the text gradually drifts down, increase the [Height (Y):] value
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Checklist
Overview of the necessary steps:

1. Turn on ClearMark printer.

2. Start ClearTools software.

3. Setup printer in ClearTools.

4. Calibrate the ClearMark printer.

5. Select marker card and enter text.

6. Insert the marker cards which correspond to the ClearTools file in the 
ClearMark printer loader.

7. On the ClearMark printer select the correct heat setting for the inserted 
marker cards.

8. Start printing with ClearTools.

A detailed description for using the ClearTools software can be found in the 
manual located on the "Printer Driver & Software" CD.

Inserting the marker cards in the ClearMark printer loader

ATTENTION: The ClearMark printer loader is suitable for use 
with Allen-Bradley marker cards only.

ATTENTION: Bent or broken side strips marker cards can result 
in the loader malfunctioning.
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Description of the Marker Card

Figure 6.1 - Description of marker card

A. Project marking surface
B.  Marking surface
C.  Side strips
D. Feed-in direction

Insert as shown

Make sure the marker cards are inserted in the correct way with the project 
marking surface facing towards the ClearMark printer.

Figure 6.2 - Insertion instructions

Insert the marker cards into the loader so that they are touching the end stop.

IMPORTANT If there are no marker cards loaded in the card feeder the "loader" button 
on the display will be flashing. Load a marker card and then press the 
"loader" button.

A

B
C

D
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Stacking heights

Do not stack the marker cards above the height of the loader paper stop.

Figure 6.3 - Stacking heights in the loader

After the first marker card has been inserted into the printer, it is printed and fed 
out to the ClearMark printer output rail. The next marker card is then separated 
out so that it can be fed in and printed.

Heating Settings With some marker cards it may be necessary to adjust the heating settings in order 
to optimize the printing quality. Take the necessary settings from the table if 
required. These settings are also provided via a message box in the ClearTools 
software.

ATTENTION: Do not exceed the maximum permitted stacking 
height when filling the loader.

ATTENTION: You can insert complete or half marker cards. Do 
not mix complete or half marker cards. 

ATTENTION: Under certain circumstances, the card separation 
process may malfunction when the maximum amount of marker 
cards is inserted. Remove a few of the marker cards from the 
loader to rectify this problem.

IMPORTANT If there are no marker cards loaded in the card feeder the "loader" button 
on the display will be flashing. Load a marker card and then press the 
"loader" button.
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Recommendations:

The ClearMark printer is now prepared for the first printing. Start up a new print 
job with the ClearTools software.

Marker Type Catalog Numbers Color
Settings

600 dpi 1200 dpi

Snap-in individual markers:
1492-M, -MC, -MCS, -MN, -SM

White

H1 H1

1492-MCW H2 H2

Snap-in linked markers
1492-MR H2 H2

1492-MS H1 H1

Snap-in hinged markers 1492-MH H1 H1

Cable markers 1492-MW H1 H1

Self-adhesive cable markers 1492-MWL H1 H1

Wire markers 1492-MWC All 
Colors H2 H2

Note: If Heating 1 causes bubbles on the surface, please change to Heating 2. 
   H1 = Heating 1, H2= Heating 2

ATTENTION: The required heat settings are dependent on 
marker type, -color, -material and operating time of the 
ClearMark printer. Please check the wipe and scratch resistance 
in regular intervals.

ATTENTION: If a print job is unintentionally carried out without 
heating it is possible to send an 'empty' print job to the printer 
and set the correct heat settings H1/H2.
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General Maintenance
Even if the printer will not be used for a prolonged period, do not turn it off. 

When using again, please observe the following:

The print-head nozzles can become dried up or clogged. You should periodically 
use the printer in order to avoid such damage. The printer should be turned on at 
least once a week for a few minutes.

If you do not use the printer for a long time, always check first to see if the nozzles 
are clear.

If necessary clean the print heads by following the procedure on "Cleaning the 
print head" and then start the printing.

If you do not use the printer for a long time, imperfections may then develop in 
the printing even if multiple print head cleanings are carried out. If this happens, 
shut down the printer for 30 minutes. Turn on the printer again and run through 
print head cleaning. Then try printing a marker card.

Cleaning the Print Head The cleaning of the print head can be done directly from the ClearTools software. 
Please take the following steps:

1. Select "Tools" from the menu pull-down, and then click on "Options".

2. In the Options window, click on the "ClearMark" folder and then on 
"Cleaning".

IMPORTANT For printer maintenance, complete by using the ClearTools software 
only. Do not use the "Maintenance" menu on the printer display.
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Figure 7.1 - Print head cleaning option

Cleaning the print head

The cleaning process cleans the print head when a printed image appears slight 
blurred. Please take the following steps:

1. Select "Cleaning type 1" and the corresponding print heads.

Figure 7.2 - Cleaning the print head

2. Click [Execute Head-Cleaning].

3. The cleaning process is initiated. This can take several minutes to run.

4. After the process has been executed by ClearMark, print out a marker card 
and check the printing quality. Repeat this process if necessary or run 
through a head-flushing process.
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Head flushing

The head-flushing process cleans the print head when a printed image appears 
very blurred. The flushing process uses more ink than the head cleaning. Please 
take the following steps:

1. Select "Cleaning type 2" and the corresponding print heads.

Figure 7.3 - Thorough cleaning

2. Click on [Execute Head-Flushing].

3. The cleaning process is initiated. This can take several minutes to run.

4. After the cleaning is complete, print out a marker card and check the 
printing quality. Repeat the process if necessary.

IMPORTANT Repeat the cleaning procedure if the print results are not satisfactory. 
It is possible that after multiple cleanings the print heads remain 
clogged and the printer still does not properly print. If multiple 
cleanings do not solve the problem, shut off the printer and allow it to 
remain off for at least eight hours. Then turn it on, and try printing 
again. The problem may be solved by allowing the ink to flush through 
the heads for an extended period of time. 

If there is still no improvement after the steps described above, 
contact your local Allen-Bradley distributor or Rockwell Automation 
Technical Support.
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Replacing the Ink 
Cartridges

Handling Ink Cartridges
• Store unopened ink cartridges in a cool and dry place, preferably in a 

refrigerator at +40 °F (+4 °C).
• Before using an ink cartridge that has been stored in a colder place, 

allow the cartridge to adjust to the room temperature for at least three 
hours.

• Install ink cartridges immediately after removing from the packaging. 
The print quality can be impaired if an ink cartridge is left unpacked for 
any length of time before use.

• Keep ink cartridges out of reach of children. 
• If you get ink on your skin, wash thoroughly with soap and water. 
• Do not shake ink cartridges, as this can cause ink to leak.
• Do not use ink cartridges beyond the expiration date printed on the 

cartridge packaging. 
• For best results, the ink in the cartridge should be used within six 

months of installation.
• Do not take apart or try to refill ink cartridges. This could result in 

damage to the print head.
• Ink is used when a new ink cartridge is inserted and when the ink tank 

cover is opened, because the ClearMark printer always carries out a 
reliability check.

• Always handle ink cartridges with care, otherwise ink could spill and 
cause contamination. 

• Never touch the ink supply outlet of the ink cartridge or the area 
around it.

• Please note that it is possible that the ink cartridges could fall out of the 
carrier.

ATTENTION: The ink cartridges are sealed units. Under normal 
circumstances, ink will not leak out of an ink cartridge.  If you 
get ink on your hands, wash them thoroughly with soap and 
water. If you get ink in your eyes, rinse immediately with water.
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Ink Cartridge Installation

• 1 x black, 1 x cyan, 1 x magenta, 1 x yellow

Figure 7.4 - Color System

Figure 7.5 - Inserting the ink-cartridge carrier

1. Open the ink cartridge cover.

2. Remove the ink cartridge carrier.

Ink cartridge from starter kit  Insert ink cartridges into 
corresponding carriers

 Snap in place
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3. Remove ink cartridge.

4. Install new ink cartridge.

5. Check the alignment and the assembly of the ink cartridge carrier. Then 
carefully place it into the printer using the following guidelines. Pay special 
attention to whether you are installing black or colored inks.

6. Press on the middle of the ink-cartridge carrier and push in until it snaps 
into place.

7. Repeat this step for all ink-cartridge carriers.

8. Close the ink-cartridge cover.

Replacing the Ink Collector 
Unit

Replace the ink collector unit if the following message is issued in the display:

1. Turn OFF the printer.

2. Remove the new ink collector unit from the packaging. Use the included 
gloves.

3. Remove the full ink collector unit from the printer.

IMPORTANT Run through the installation procedure as detailed in the instructions 
before turning on the printer!

     

ATTENTION:  If the ink comes into contact with your eyes wash out 
immediately with water.  If the ink comes into contact with your skin 
wash the affected area thoroughly with soap and water. If you 
swallow ink rinse your mouth and drink plenty of water.

R e p l a c e  I n k

C o l l e c t o r  U n i t
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Figure 7.6 - Replacing the ink collector unit

4. Place the full ink collector  unit into the provided bag and dispose.

5. Insert the new ink collector unit into the printer.

6. Close the cover so that it snaps firmly into place.

7. Turn ON the printer.

8. A message in the printer display requests you to reset the internal counter 
or the display continues to display the message:

9. Press the [Menu] key

10. Use the arrow keys to select System then press the [Enter] key.

11. Confirm the following display texts by pressing the [Enter] key:

12. Turn the printer OFF, then ON again. 

R e p l a c e  I n k

C o l l e c t o r  U n i t

M e n u :

S y s t e m

S y s t e m :

I n k  C U  R e p l a c e

O v e r f l o w  m a y

o c c u r  i f  U n i t  i s

n o t  r e p l a c e d .

R e s e t  c o u n t e r s ?

R e s e t  c o m p l e t e

P o w e r  O f f / O n
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General Cleaning
Clean the outside of the printer regularly by wiping it with a soft cloth that is 
either dry or moistened with water.

If the dirt does not come off, wipe the printer with a cloth moistened with a 
neutral cleaning agent. Next wipe with a cloth moistened with water and then 
with a dry cloth.

Transport and shipment

Preparation:

1. Turn off the printer.

2. Unplug all cables (power cord, interface cable) from the printer.

3. Remove the remaining marker cards from the loader.

4. Remove the ink waste pad and place in a sealed plastic bag. Enclose this 
along with the printer.

ATTENTION: Do not use volatile chemicals such as benzene, 
thinning fluid or insecticide on the printer. The use of such 
chemicals can result in damage to the printer including cracks or 
color changes. If you use a cloth moistened with a cleaning 
agent, be careful that you only clean the outside of the device. 
None of the moisture should be allowed inside of the printer.

ATTENTION: In order to avoid dangerous electric shock you 
should only clean the outside of the printer. Contact your local 
Allen-Bradley distributor or Rockwell Automation Technical 
Support if the printer needs to be checked, adjusted or repaired.

Do not take the printer apart and do not try to conduct 
modifications or repairs by yourself. 

By doing so you risk fire, electric shock, explosion or personal 
injury.

In addition, such actions would void the warranty.

IMPORTANT Please do not throw away the original packaging. Always use the 
original packaging when transporting the printer over long distances 
(for example moving or returning). Only then can the maximum 
protection for the printer during transport be guaranteed.
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5. Place the printer carefully into the box. Be certain to lift the printer using 
only the recessed grips provided.

6. Put the protective foam into place.

7. Close and seal the box.
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Troubleshooting

LED Displays

See the following table for the meaning of the LED Displays

Table 8.1 -  LED Error Displays

LED Type Cause Troubleshooting Information

Transport Flashing A marker card may be 
stuck in the heating unit

Turn off the system and then turn it on
again in order to initialize.

The marker card is then transported out of the
printer.

If the card is not fed out of the printer, proceed
as follows:
• Turn off the printer and wait until it has cooled off.

• Unplug the power cord. If possible remove the marker card from 
the system. Restart the system.

• If the problem remains, please contact your local Allen-Bradley 
distributor or Rockwell Automation Technical Support.

Temperature

Flashing Excess temperature was 
reached

The heater is shut off immediately.

Wait until the heating unit has cooled off.

When the heating unit is cooled off, the system
will be automatically reactivated.

If the error occurs again, please contact your local Allen-Bradley 
distributor or Rockwell Automation Technical Support.

Illuminated Upper temperature limit 
has been reached

The heating unit has reached a limit value.
The current print job is finished. The next
print job is then delayed until the heating unit cools.
but then automatically processed.

Heating 1 Flashing The heating unit is 
currently heating up

Wait until the unit has reached its operating temperature 
(< 1 minute).

Heating 2 Flashing The heating unit is 
currently heating up

Wait until the unit has reached its operating temperature 
(< 1 minute).

Heating 1 and Heating 2 Both Not 
Illuminated

The heating unit is not 
activated

Heating is deactivated.
This setting can be used for sample test printing or for measuring 
the system without print fusing.

Loader

Flashing No marker card could be 
separated and fed in. Insert marker card and press the "Loader" button.

Illuminated Loader mode is activated

Not Illuminated Loader mode is not 
activated

Inlay (Printing material other 
than marker cards) Flashing No inlay or marker card 

could be fed in Place an inlay on the conveyor and press the Inlay button
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General Troubleshooting If the print results are not satisfactory or the printed image is too weak or is 
spotted, check the printer status.

Check the printer status

Print out an example marker card in order to check if all print-head nozzles are 
emitting ink properly. If necessary, carry out a normal print head cleaning or a 
head flushing. Proceed as described below:

If the printed marker card print appears blurry, you should carry out a head 
cleaning (refer to Chapter  "Maintenance") and then print out another 
marker card.

Carry out these steps (head cleaning and head flushing) a few more times. 
Then check if the test pattern continues to show errors.

Has the printer not been in use for a week or longer?

It is then possible that the ink has dried up or that the print-head nozzles are 
clogged. Print out an example marker card and clean the print heads if necessary 
(refer to Chapter "Maintenance").

Is the printed image unclear or doubled?

Make sure that the printer is situated on a flat even surface. The printer should be 
located at a site that's free from vibration or excessive forces.

A marker card becomes stuck / caught in the device

Switch off the device then switch it on again. The card caught in the device will 
be transported out of the device.

The print is irregular, either too strong or too weak.

If there is a problem with the print quality, such as irregular print or 
inappropriate ink quantity, the following issues should be addressed:

• Is an old ink cartridge being used?

IMPORTANT Even if the printer will not be used for a week or longer, do not turn it off. 
Leaving the printer on ensures optimal ink life and print quality.
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Ink cartridges should only be used before the expiration date.
• Is the print quality setting correct?

Using the ClearTools software, make sure that the printer driver is set 
correctly to either Standard or Quality (See page 4 - 3).

Dirty or spotted printouts

If the printed marking surface is dirty or spotted, focus on the following:
• Have you touched the unprinted marker card?

Avoid touching the unprinted marking surface before the printing 
process.

• Are the marker cards aligned correctly?
Verify the alignment of the inserted marker cards.

• Is an original ink cartridge being used?
If you do not use an original ink cartridge, or if you are using a refilled 
cartridge, the print quality can worsen and functional problems can 
result. Only use original ink cartridges, as the ink is specially formulated 
to fuse with the marker cards.

Check the settings for the printer driver

If a problem occurs with regard to the printer status, use ClearTools to check the 
printer driver (please refer to ClearTools User Manual).

Opening the Maintenance Cover During Printing 

Printing will be aborted if the maintenance cover is opened when the printer is 
printing. After the cover is closed printing will resume briefly and then be 
aborted. The card will be fed forward, but remains in the device. A transport 
error will be signalized via the display (blue LED will light up). Switch off the 
device then switch it on again. The card caught in the device will be transported 
out of the device.

Opening the Ink Tank Cover During Printing

Printing will be aborted if the ink tank cover is opened when the printer is 
printing. After the cover is closed printing will resume briefly and then will be 
aborted. The card will be fed forward, but remains in the device. A transport 
error will be signalized via the display (blue LED will light up). The ink tank 
status indicators will change to empty. The printer will automatically re-initialize 
the ink tank system (takes up to 2 minutes).
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Switch off the device then switch it on again. The card caught in the device will 
be transported out of the device.

Control Panel Messages

See the following table for the meaning of messages displayed on the control 
panel

Error Message Meaning

Power off/on call service if 
error reoccurs

An error has occurred.

Switch the printer off and then on again. If the message is 
still displayed contact your local Allen-Bradley distributor 
or Rockwell Automation technical support.

Ready The printer is able to print.

Printing... Printer is currently printing

Close Duplex Unit Cover A cover or lid is opened. Close all covers and lids.

Change Setting Tray
The paper format in the selected loader does not
correspond to the specified paper format.
Reset the driver settings using the ClearTools
software.

Setting change The printer is changing its settings. Please wait for a
moment.

Energy Saver The printer is in low-energy mode. The printer is
ready for use.

Loading Ink... Ink is being supplied. Please wait for a moment

Ink Collector almost full
The ink waste pad is almost full.
Make sure that a new ink waste pad is readily available 
(Cat. No. 1492-INKCOLLECT).

Ink Collector is full/Replace 
Ink Collector Unit The ink waste pad is full. Replace it with a new one

Network Interface Board 
Error

An error in the network interface board network function
has occurred. Switch the printer off and then on again.

If the message is still displayed, contact your local 
Allen-Bradley distributor or Rockwell Automation technical 
support.

Guide Board is open/Close 
the Guide Board Close all covers and lids.

Hardware Problem Ethernet An error in the network interface board (Ethernet
board) network function has occurred.

Resetting Job... The printer is initializing a new print job.
Please wait for a moment.

Close Top Cover or reset the 
Duplex Unit correctly

A cover or lid is open or not seated correctly. Close
all covers and make sure they are all seated correctly.

Offline The printer is offline. The printer must be switched to
online before printing.
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Load Paper: Tray# or Form 
Feed

The loader is empty or the print system is currently
heating up.

Fill the loader.

Remove Misfeed Bypass Turn the printer off, then back on.

Remove Misfeed Duplex Turn the printer off, then back on.

Remove Misfeed Tray 1 There is a paper jam in the loader. Clear the jam in
the loader.

Remove Misfeed Top Cover Turn the printer off, then back on.

Right Front Cover is 
open/Close Right Front
Cover

A cover or lid is opened. Close all covers and lids.

Remove Misfeed Output Turn the printer off, then back on.

Remove Misfeed Guide 
Board Turn the printer off, then back on.

Ink depleted The inserted ink cartridge is empty.
Replace the ink cartridge.

Reset Cartridge No ink cartridge has been installed. Properly install
the ink cartridge.

Cannot use High 
Temp./Power Off On

The temperature is abnormally high.
Turn the printer off and then on again. 

If the message is still displayed, contact your local 
Allen-Bradley distributor or Rockwell Automation technical 
support.

Cannot use Low 
Temp./Power Off On

The temperature is abnormally low.
Turn the printer off and then on again. If the message
is still displayed, contact your local Allen-Bradley 
distributor or Rockwell Automation technical support.

Waiting... Please wait for a moment.

Maintenance in process... The printer is currently cleaning or flushing the print
head. Please wait for a moment.

Low Ink

The ink is running out. Be prepared to replace the ink 
cartridge. 
Cat. No. 1492-PRINTINK -K (Black)
Cat. No. 1492-PRINTINK -C (Cyan) 
Cat. No. 1492-PRINTINK -M (Magenta)
Cat. No. 1492-PRINTINK -Y (Yellow)

Error Message Meaning
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Appendix

Technical Data

Specifications

Application Printing Allen-Bradley marker cards

Printing technology Ink-jet process with heat fusing

Print quality 600...1200 dpi

Printer drivers RPCS driver; WIN XP/2000; VISTA

Printing software ClearTools software recommended

System requirements WIN XP/ 2000; VISTA

Feed Automatic loader, maximum 20 marker cards

Interface USB 1.1/ 2.0 and 10 Base-T/100 Base-TX

Power supply 100...120V AC/ 4 A, 50/60 Hz or 220...240V AC/ 4 A, 50/60 Hz

Fuses Top fuse: 10 A delay 240/120V
Lower fuse: 2.5 A fast fuse 240/120V

Operating location Office conditions

Ambient Temperature  +68...+95 °F (+20...+35 °C)

Approximate dimensions 
(without output rail) (L x W x H) 41.7 x 19.7 x 11.8 in. (1060 x 500 x 300 mm)

Approximate Weight 65 lb. (30 kg)

Ink System

Color system: 1 each of black, cyan, magenta and yellow cartridges
Cat. No. 1492-PRINTINK- K (Black)
Cat. No. 1492-PRINTINK- C (Cyan)
Cat. No. 1492-PRINTINK- M (Magenta)
Cat. No. 1492-PRINTINK- Y (Yellow)

Ink Collector Unit Cat. No.1492-PRINTCOLLECT

Range 25 ml for each ink cartridge

Included in delivery
Power cord, USB cable, printer driver and ClearTools Software CD, 
QuickStart Guide, output rail, 2 marker cards, Printer and Software 
user manuals.
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Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. At 
http://www.rockwellautomation.com/support/, you can find technical manuals, a knowledge base of FAQs, technical and application 
notes, sample code and links to software service packs, and a My Support feature that you can customize to make the best use of these 
tools.

For an additional level of technical phone support for installation, configuration, and troubleshooting, we offer Tech Connect support 
programs. For more information, contact your local distributor or Rockwell Automation representative, or visit  
http://www.rockwellautomation.com/support/.

Installation Assistance

If you experience an anomaly within the first 24 hours of installation, review the information that is contained in this manual.
You can contact Customer Support for initial help in getting your product up and running.

New Product Satisfaction Return 

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the manufacturing facility. 
However, if your product is not functioning and needs to be returned, follow these procedures.

Documentation Feedback 

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, 
complete this form, publication RA-DU002, available at http://www.rockwellautomation.com/literature/.

Allen-Bradley, Listen. Think. Solve., Rockwell Automation, Rockwell Software, ClearMark, and ClearTools are trademarks of Rockwell 
Automation, Inc.

United States or Canada 1.440.646.3434

Outside United States or 
Canada

Use the Worldwide Locator at http://www.rockwellautomation.com/support/americas/phone_en.html, or contact 
your local Rockwell Automation representative.

United States Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain 
one) to your distributor to complete the return process.

Outside United States Please contact your local Rockwell Automation representative for the return procedure.
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